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List of Reports 

First-time users, start here: Pages 5-7. 

Returning users, this table is a complete listing of current reports: 

Report Type Description Report 
Location 

Award   

100 – Active Awards Active Awards, by Investigator, for User-specified Unit. Unit Hierarchy 

100e – Active Awards Excel data file of Active Awards, by Investigator, for User-
specified Unit. Unit Hierarchy 

102 – Awards by Start Date Awards within User-specified date-range for a Unit. Unit Hierarchy 

104/104e – Award Years by Start Date Award Years within User-specified date range for a Unit. Unit Hierarchy 

110, 112, 114, 116, and 118  
     Award Revenue Projections 

Award Revenue, by Investigator, Department, School, or 
Enterprise for User-specified date range. Unit Hierarchy 

Institute Proposal   

300 – Pending Proposals Pending Proposals, by Investigator, for User-specified Unit. Unit Hierarchy 

300e – Pending Proposals Excel data file of Pending Proposals, by Investigator, for 
User-specified Unit. Unit Hierarchy 

302e – Funding Analysis Excel data file of Proposals and, if funded, their Award 
information. Unit Hierarchy 

310, 312, 314, 316, and 318  
     Proposal Revenue Projections 

Pending Proposal prorated budget amounts, by 
Investigator, Department or School for User-specified date 
range. 

Unit Hierarchy 

320, 322, and 324 Success Rate Proposal success rate by Investigator, Department, School, 
or Enterprise for User-specified date range. Unit Hierarchy 

326 and 328 – Funding Status  Total of Pending Proposals and Awards for the current 
budget period, for School or Enterprise Unit Hierarchy 

Proposal Development   

500e - Routing Analysis Excel data file of Proposal Development records, for User-
specified Unit. Unit Hierarchy 

510 – Coeus Users in Unit Coeus active Users and their assigned Coeus roles, for User-
specified Unit. Unit Hierarchy 

Person   

700 – Investigator History All Awards and Institute Proposals for User-specified 
Investigator. Person Search 

702e– Other Support Tool Excel data file of proposals and awards on with User-
specified Investigator may have been budgeted for Effort. Person Search 

710 – Coeus Roles for Users Coeus roles assigned to an individual user, for User-specified 
person. Person Search 
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Before You Begin 

First-time Users 

Follow these steps 

ORIS reports are generated in Coeus Premium, from specific locations – but, not from the Main Screen of 
Premium.  The menu of reports available under the word “Report” in the Top Menu Bar changes as you 
navigate to different screens (Report Locations) within Coeus. 
   
First-time report Users, or those exploring the content of new reports, should follow these steps:  

1. Read pages 5-6 to understand ORIS process and content.  
2. Identify a report: List of Reports, Table of Contents, or Catalog of ORIS Reports. 
3. Determine report’s ‘Report Location’: see hyperlinked ‘Report Location’ to see location 

description. 
4. Navigate: to Report Location. 
5. Select: from Top Menu Bar, Report>[dropdown menu]. 
6. Enter: any required report parameters. 
7. Select: report format & print. 

What are sources of ORIS Report data? 
ORIS Reports derive award data from SAP GM Grant (imported into Coeus Award Module) and Coeus 
Institute Proposal Module. 
 Information in the Awards Module is derived from two external sources: SAP and ReSource. 

 SAP GMGrant and GMProgram Master Data are the source of Coeus active Award data, including 
internal orders.  Updated every fifteen minutes, so Sponsored Projects Shared Services postings 
are nearly real-time in Coeus. 

  JHU’s legacy ORA database, ReSource, has been imported into Coeus to augment the SAP/Award 
information.  All awards from ReSource have a Status of Terminated.  Though ORA maintenance 
of ReSource ended when SAP was implemented on January 1, 2007, ReSource contained 
thousands of awards dating back to 1996.  Those award Projects are in Coeus and displayed in 
ORIS reports depending on User-entered parameters.  

 Information in Proposal Development and Institute Proposal Modules is entered by Investigators and 
their staff under guidance of the five Offices of Research Administration (ORAs). 

Important caveats: 

What does ‘Active’ Award mean in Coeus? 

Coeus Award has a slightly more stringent definition of awards that are ‘active’, then does SAP.  In SAP 
awards are considered ‘active’ with the Lifecycle Status is ‘Award’ and User Status is ‘Approved Award’.  As 
Coeus imports these (and displays them in ORIS Reports) it also examines the SAP Grant Project End Date.  
If the Project End Date is on or after today’s date, then the Coeus award status will be made ‘Active’.  If 
however, the SAP Project End Date is prior to today’s date the Coeus award status is changed to 
‘Terminated’. 
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What Proposal Types are included in Institute Proposal ORIS Reports? 

Institute Proposals with Proposal Type of: New, Renewal, Supplement, Resubmission, and Task Order are 
the only Proposal Types included in ORIS Reports.  These five Proposal Types are proposals for which 
research funding is being requested - and has not been previously requested.   

Institute Proposal numbers are 8-digit in length.  The first two digits (12xxxxxx) is the Fiscal Year the 
Proposal was first submitted by the Investigator for Research Administration approval.  The second two 
digits (yy12xxxx) represent the fiscal month of that first submission.  For example, Institute Proposal 
14020933 was first routed for approval in August 2013.   Last four digits are sequential and reset each 
month. 

What to do if your ORIS ‘e’ report displays xml code, in red ink, and not Excel? 

1) If your ORIS report looks like this: 

  
2) Select: File>Save As.  
3) Save: to Desktop.  
4) Name the file.  
5) Do not change the File Type.  
6) Close the file. 
7) Either: 

a. Place cursor on the just-saved file. 
b. Select: Mouse – Right button.  
c. Select: ‘Open with’.  
d. Select: Excel (note: if ‘Excel’ is not an option, contact your PC Support person or see ORIS 

website>TipSheet: When the ORIS Report has red code). 
8) Or: 

a. Double click on the just-saved file to open. 
b. Select File > Save As. 
c. Immediately change the File Type to Excel Workbook. 
d. Save the Excel file as you normally do. 

9) Delete original file from Desktop. 
10) So, what happened?  XML, “Extensible Markup Language”, is a highly efficient language for transporting 

large amounts of data over the internet.  Coeus Grants.gov submissions use XML and so does the ORIS 
Reports ‘e’ reports 
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Where to report data errors found in ORIS Reports? 
You may encounter several different types of data-errors in ORIS Reports that were not previously 
apparent in BW or other reporting tools.  Report errors as follows: 

 Report errors found in Pending Projects (Institute Proposals) to your Office of Research 
Administration, including: 
 Wrong Status 
 Wrong IPN associated with an award 
 Wrong Co-Investigators 

 Report errors in Awarded Project data to Sponsored Projects Shared Services, including: 
 Wrong award amounts – Direct, Indirect, Total Costs 
 Wrong award dates – Project Start/End Dates  

Where to direct questions about accessing or generating ORIS Reports? 
Send questions concerning accessing or executing ORIS Reports: 

 coeus-help@jhu.edu - place ‘Reports’ in the Subject line. 

mailto:coeus-help@jhu.edu
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Catalog of ORIS Reports 

Award Reports (100 series) 

100: Active Awards 
[return to List of Reports] 

Description: This report contains Active Awards, by Investigator, for a User-specified Unit.  
Investigator data shown in this report pertains only to Awards created under this reporting unit.  
Information provided: Award number, Sponsor Award number (SAP Award ID), Sponsor Name, Award 
Start/End dates, Award Direct Cost and Total. 

*Note: The information in this report is updated once a day at 6:00AM.   

Report Location:  Unit Hierarchy 

Definition of Terms:  Column Headings & Terms Defined 
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100e: Active Awards Excel Data File 
[return to List of Reports] 

Description: This report is the Excel data file format of Report 100 Active Awards.  The report contains 
Active Awards, by Investigator, for a User-specified Unit.  Investigator data shown in this report 
pertains only to Awards created under this reporting unit.  Information provided: Award number, 
Sponsor Award number (SAP Award ID), Sponsor name, Award Start/End dates, Award Direct Cost and 
Total. 

*Note: The information in this report is updated once a day at 6:00AM.   

Report Location:  Unit Hierarchy 

Definition of Terms:  Column Headings & Terms Defined 
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102: Awards Received by Start Date Report 
[return to List of Reports] 

Description: This report contains all Awards, by Investigator, for a User-specified Unit, or aggregation of 
Units (School, Departments, Sub-departments, Centers), and User-specified range of Award Start Dates.  
Investigator data shown in this report pertains only to Awards created under this reporting unit.  
Information provided: Award number, Sponsor Award number (SAP Award ID), Sponsor name, Award 
Type, Activity Type, Award Status, Award Start/End dates, Total Direct Cost and Total Indirect Cost. 

*Note: The information in this report is updated once a day at 6:00AM.   

Report Location:  Unit Hierarchy 

Definition of Terms:  Column Headings & Terms Defined 
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104/104e: Award Years Received by Start Date Report 
[return to List of Reports] 

Description: 104 is a PDF format, shown below and 104e is an Excel file, not shown.  This report displays 
Awards begun during the User-specified date range, by Investigator, by User-specified Unit and 
aggregation of Units (School, Departments, Sub-departments, Centers).  Amounts shown are from the 
Award Year Breakdown applicable Budget Begin/End Dates.  Investigator data shown in this report 
pertains only to Awards created under this reporting unit. 

Information provided:   

Award # Sponsor Activity Type Award Type 

A.Y. [AYB row #] Award Action [AYB] Start/End Dates [AYB] Direct Cost 

Indirect Cost    

 

Report Location:  Unit Hierarchy 

Definition of Terms:  Column Headings & Terms Defined 
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110, 112, 114, 116, and 118: Award Revenue Projection Reports 
[return to List of Reports] 

Description: Prorated Award revenue, by Investigator, Department, School, or Enterprise for User-
specified date range.  Information provided: Unit Number and Name, Investigator, Award Number, Title, 
Award Type, Activity Type, Project End Date, Direct Cost, Indirect Cost, and Total Cost. 

How Award Revenue Projection Reports calculate prorated projections: Calculations 

 

Report Type Description Report 
Location 

Award Revenue Projection   
110 – Investigator Award Revenue 

Projection 
Departmental award revenue, by Investigator, for User-
specified date range Unit Hierarchy 

112 – Department Award Revenue 
Projection 

Award revenue prorated for User-specified date range and 
User-specified Department Unit Hierarchy 

114 – School Award Revenue Projection Award revenue prorated for User-specified date range and 
User-specified School Unit Hierarchy 

116 – Enterprise Award Revenue 
Projection, By School 

Award revenue prorated for User-specified date range, by 
School Unit Hierarchy 

118 – Enterprise Award Revenue 
Projection, By Investigator 

Award revenue prorated for User-specified date range, by 
Investigator Unit Hierarchy 
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Award Revenue Projection Calculations 
[return to List of Reports] 

[return to List of Award Revenue Projection Reports] 

How Revenue is projected from GM Grant Master Data>Award Year Breakdown. 

ORIS calculates the portion of each funding increment in an award, the Prorated Amount, by comparing 
the Report’s start/end dates to Budget Dates on the SAP GM Grant Award Year Breakdown Tab.  There are 
four Award Increment Types: 

Type #1: award Budget begins before reporting period and ends during. 
Type #2: award Budget begins before reporting period and ends after. 
Type #3: award Budget begins during reporting period and ends after. 
Type #4: award Budget begins during reporting period and ends during. 

In this example, Report Period is July 1, 2009-June 30. 2010: 

 
Steps followed to calculate each prorated amount are: 
Type #1: 

a) # days Award Increment is active, ex 2/1/09 - 1/12/10 = 345 
b) add 1 day to 345 = 346 (*)  
c) # days Award is funded within report's period, ex. = 195 
d) add 1 day to 195 = 196 (*)  
e) 196/346 = 56.647%  
f) % * AYB amount = Prorated Award amount reported = $566.47.   

Type #2:  
a) # days Award Increment is active, ex 1/13/07 - 8/31/10 = 1,326  
b) add 1 day to 1,326 = 1,327 (*)  
c) # days Award is funded within report's period, ex. = 364 
d) add 1 day to 364 = 365 (*)  
e) 365/1,327 = 27.506%  
f) % * AYB amount = Prorated Award amount reported = $275.06.  

Type #3: 
a) % * AYB amount = Prorated Award amount reported = $275.06 
b) add 1 day to 772 = 773 (*) 
c) # days Award is funded within report's period, ex. = 211  
d) add 1 day to 211 = 212 (*)  
e) 212/773 = 27.426%  
f) % * AYB amount = Prorated Award amount reported = $274.26.  

Type #4: 
a) n/a  
b) n/a  
c) # days Award is funded within report's period, ex. = 37  
d) add 1 day to 37 = 38 (*)  
e) 38/38 = 100%  
f) 100% * AYB amount = Total Award amount reported = $1,000.00. 

__________________________________________________ 
(*) Excel & Oracle calculate dates by counting the 'lines' between the 'days', effectively not counting the first day in the range; 
therefore, 1 must be added to date calculations. As an example, Excel calculates 364 'days' in the calendar year 1/1/11 - 12/31/11, not 365.   

  



October 31, 2019  14 
 

 

110: Investigator Award Revenue Projection Report 
[return to List of Reports] 

[return to List of Award Revenue Projection Reports] 

 

Description:  This report provides departmental Award revenue estimates, by Investigator, for a User-
specified date range.  Totals are provided for each Investigator and for the Department.  Investigator data 
shown in this report pertains only to Awards created under this reporting unit.  Information provided: Unit 
number and name, Investigator, Award number, Title, Award Type, Activity Type, Project End Date, Direct 
Cost, Indirect Cost, and Total Cost. 

Report Location:  Unit Hierarchy 

How Award Revenue Projection Reports calculate prorated projections: Calculations 

Definition of Terms:  Column Headings & Terms Defined 
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112: Department Award Revenue Projection Report 
[return to List of Reports] 

[return to List of Award Revenue Projection Reports] 

 

Description:  This report provides total departmental Award revenue estimates, by subunit and by 
Investigator, for a User-specified date range.  Investigator data shown in this report pertains only to 
Awards created under this reporting unit.  Information provided: Unit number and name, Investigator, 
Award Count, Direct Cost, Indirect Cost, and Total Cost. 

Report Location:  Unit Hierarchy 

How Award Revenue Projection Reports calculate prorated projections: Calculations 

Definition of Terms:  Column Headings & Terms Defined 
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114: School Award Revenue Projection Report 
[return to List of Reports] 

[return to List of Award Revenue Projection Reports] 

 

Description:  This report provides prorated School Award revenue estimates, by Department, for a User-
specified date range.  Information provided: Unit number and name, Award count, Direct Cost, Indirect 
Cost, and Total Cost. 

Report Location:  Unit Hierarchy 

 

(This dropdown menu overrides any specific unit highlighted in the Unit Hierarchy.) 

How Award Revenue Projection Reports calculate prorated projections: Calculations 

Definition of Terms:  Column Headings & Terms Defined 
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116: Enterprise Award Revenue Projection Report 
[return to List of Reports] 

[return to List of Award Revenue Projection Reports] 

 

Description:  This report provides prorated Enterprise Award revenue estimates, by School, for a User-
specified date range.  Information provided: Unit number and name, Award count, Direct Cost, Indirect 
Cost, and Total Cost. 

Report Location:  Unit Hierarchy 

 

(This dropdown menu overrides any specific unit highlighted in the Unit Hierarchy.) 

How Award Revenue Projection Reports calculate prorated projections: Calculations 

Definition of Terms:  Column Headings & Terms Defined 
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118: Investigator Award Revenue Projection Report 
[return to List of Reports] 

[return to List of Award Revenue Projection Reports] 

 

Description: This report provides prorated Award revenue estimates, by Investigator across the Enterprise, 
for a User-specified date range.  Information provided: Investigator, Award count, Direct Cost, Indirect 
Cost, and Total Cost. 

Report Location:  Unit Hierarchy 

   

(This dropdown menu overrides any specific unit highlighted in the Unit Hierarchy.) 

How Award Revenue Projection Reports calculate prorated projections: Calculations 

Definition of Terms:  Column Headings & Terms Defined 
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Institute Proposal Reports (300 series) 

300: Pending Proposals Report 
[return to List of Reports] 

Description: This report lists Institute Proposals, by Investigator, which have been submitted to sponsor, 
but not yet funded.  It is generated for a User-specified Unit, or aggregation of Units (School, 
Departments, Sub-departments, Centers).  Investigator data shown in this report only pertains to Institute 
Proposals created under this reporting unit.  Information provided: Institute Proposal number and link to 
ORIS Proposal Summary Form, Sponsor name, Award Type, Activity Type, Proposal Type, Proposal Start 
date, Direct Cost, Indirect Cost, and Total Cost. 

*Note: The information in this report is updated once a day at 6:00AM.   

Report Location:  Unit Hierarchy 

Definition of Terms:  Column Headings & Terms Defined 
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300e: Pending Proposals Excel Data File 
[return to List of Reports] 

Description: This report is the Excel data file format of Report 300 Pending Proposals.  The report lists 
Institute Proposals, by Investigator, which have been submitted to sponsor, but not yet funded.  It is 
generated for a User-specified Unit, or aggregation of Units (School, Departments, Sub-departments, 
Centers).  Investigator data shown in this report only pertains to Institute Proposals created under this 
reporting unit.  Information provided: Institute Proposal number, Sponsor name, Award Type, Activity 
Type, Proposal Type, Proposal Start date, Direct Cost, Indirect Cost, and Total Cost. 

*Note: The information in this report is updated once a day at 6:00AM.   

Sorted by: Institute Proposal number, descending 

Report Location:  Unit Hierarchy 

Definition of Terms:  Column Headings & Terms Defined 
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302e: Funding Analysis Report 
[return to List of Reports] 

Description: This report contains proposal information and, if applicable, corresponding funding 
information for Institute Proposals in a User-specified fiscal year(s).  The report offers the detailed analysis 
of Success Rates and Rates of Funding based on the Institute Proposals by time period, by proposal 
characteristics, by Unit (Department, Division) and by Sponsor characteristics.  The definitions and 
formulas for Success Rate and Rate of Funding are in the Column Headings & Terms Defined section. 

The fiscal year and month are based on the first four digits of the Institute Proposal number.  See the 
second paragraph of What Proposal Types are included in Institute Proposal ORIS Reports? in the Before 
You Begin section.  The Fiscal Year is literally the first two digits of the Institute Proposal number and the 
Fiscal Month is the third and fourth digits of the Institute Proposal number.  Columns A through AI pull 
information from the Institute Proposal and Columns AJ through AP pull information from the 
corresponding Award, if applicable. 

Note regarding the DHHS transition to PMS Subaccount billing: Please see the official NIH notice here.  If DHHS switches the billing 
mechanism for an award mid-project (for example, at the start of Year 4 of a five year award), SAP requires the creation of a new SAP 
Grant number for the period(s) awarded through the PMS Subaccount.  If this occurs and the project is processed correctly, ORIS 
Report 302e will report the project as follows.  The original Institute Proposal number and all of its original information will be 
included in the report.  The award information for the Institute Proposal will pull from both the original SAP Grant and new (PMS 
Subaccount) SAP Grant as described: Award number = new SAP Grant number, Award Status = new SAP Grant status, Award Start = 
original SAP Grant start date, Award End = new SAP Grant end date, Anticipated Total = the summation of the Funded Amounts from 
both SAP Grants minus all awarded Supplements, Award Date = original SAP Grant award date.  Please contact the ORA with 
questions about PMS Subaccounts and contact ORIS with questions regarding PMS Subaccount reporting. 

Report Location:  Unit Hierarchy 

Definition of Terms:  Column Headings & Terms Defined 

Information provided:  

Fiscal Year Fiscal Month Inst. Proposal Number Proposal Type 

Activity Type Anticipated Award Type Proposal Status Business Area (*) 

Unit Number Unit Name Department Division 

Aggregated Division (*) Title Sponsor Code Sponsor 

Sponsor Type Aggregated Sponsor Type (*) Prime Sponsor Code Principal Investigator 

Employee ID (of PI) Request First Period Start Request Total Period Start Request First Period End 

Request Total Period End Request First Period Direct Request Total Period Direct Request First Period Indirect 

Request Total Period Indirect Request First Period Total Request Total Period Total Announcement Number 

Subcontract Flag ARRA Proposal ORA Submission Date 

Award Number Award Status Award Start Award End 

Anticipated Total Award Date ARRA Award  

Notice about Descriptors 

Caution: if the following fields 
are removed from the 

spreadsheet ORIS will be 
unable to validate the data. 

Report Number(#) Report Title(#) Parameter Entered 1(#) 

Parameter Entered 2(#) Parameter Entered 3(#) Run Time(#) Host Name(#) 

(*) Indicates data fields which enable the report to be used across the enterprise. 

(#) Indicates crucial ORIS report information inserted into every row of the report which enable each row of data to be replicated.  
 

http://grants.nih.gov/grants/guide/notice-files/NOT-OD-14-103.html
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Below is a partial sample report. The User-specified variables were: 
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310, 312, 314, 316, and 318: Proposal Revenue Projection Reports 
 

[return to List of Reports] 

Description: Pending Proposal prorated budget amounts, by Investigator, Department or School for User-
specified date range.  Information provided:  Unit Number and Name, Investigator, Institute Proposal 
number, Title, Award Type, Activity Type, Project End Date, Direct Cost, Indirect Cost, and Total Cost. 

How Proposal Revenue Projection Reports calculate prorated projections: Calculations 

 

Report Type Description Report 
Location 

Proposal Revenue Projection   
310 – Investigator Proposal Revenue 

Projection 
Departmental pending proposal prorated budget amounts, 
by Investigator, for User-specified date range Unit Hierarchy 

312 – Department Proposal Revenue 
Projection 

Pending prorated budgeted amounts for User-specified 
date range and User-specified Department Unit Hierarchy 

314 – School Proposal Revenue 
Projection 

Pending prorated budgeted amounts for User-specified 
date range and User-specified School Unit Hierarchy 

316 – Enterprise Proposal Revenue 
Projection, By School 

Pending prorated budgeted amounts for User-specified 
date range, by School Unit Hierarchy 

318 – Enterprise Proposal Revenue 
Projection, By Investigator 

Pending prorated budgeted amounts for User-specified 
date range, by Investigator Unit Hierarchy 
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Pending Proposal Budgeted Revenue Projection Calculations 
[return to List of Reports] 

[return to List Proposal Revenue Projection Reports] 

How Revenue is projected from Pending Proposals. 

 
ORIS calculates the portion of each prorated Pending Proposal by multiplying the average daily Total Period 
requested amount by the number of days contained in the User-specified date range. 
 
Example – calculating the prorated Direct Cost to be reported for the first Institute Proposal (submitted 
proposal) of Fiscal Year 2014 (i.e. #14010001): 
 
1) Project (proposal) Dates: 

i) Start Jan. 1, 2015 
ii) End Dec. 31, 2019 

 
2) Project Budget: 

i) Yr 1-5, Direct Cost  $3,000,000 
ii) Yr 1-5, Indirect Cost  $2,000,000 
iii) Yr 1-5, Total Cost  $5,000,000 

 
3) User-specified Report date range: 

i) 9 months: 
(1) August 15, 2015 - 
(2) May 14, 2016. 
 

4) ORIS REPORTS will calculate the Direct Cost by: 
a) Project (proposal) info: 

i) Project (proposal) Days: 
(a) 1,826 days (1/1/2015 – 12/31/2019) 

ii) Project (proposal) Direct Cost: 
(a) $3,000,000 

iii) Average Project (proposal) Direct Cost per day: 
(a) $1,642.94 

b) Reported data: 
i) Report data range: 

(a) 274 days (8/15/2015 – 5/14/2016) 
ii) Reported Direct Cost: 

(a) $450,164 (274 x $1,642.94) 
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310: Investigator Proposal Revenue Projection Report 
[return to List of Reports] 

[return to List Proposal Revenue Projection Reports] 

 

Description:  This report provides departmental prorated Pending Proposal requested amounts, by 
Investigator, for a User-specified date range.  Totals are provided for each Investigator and the 
Department.  Investigator data shown in this report pertains only to Institute Proposals created under this 
reporting unit.  Information provided: Unit number and name, Investigator, Institute Proposal number, 
Title, Award Type, Activity Type, Project End Date, Direct Cost, Indirect Cost, and Total Cost. 

Report Location:  Unit Hierarchy 

How Proposal Revenue Projection Reports calculate prorated projections: Calculations 

Definition of Terms:  Column Headings & Terms Defined 
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312: Department Proposal Revenue Projection Report 
[return to List of Reports] 

[return to List Proposal Revenue Projection Reports] 

 

Description:  This report provides departmental Pending Proposal prorated requested amounts, by subunit 
and by Investigator, for a User-specified date range.  Investigator data shown in this report pertains only to 
Institute Proposals created under this reporting unit.  Information provided: Unit number and name, 
Investigator, Institute Proposal count, Direct Cost, Indirect Cost, and Total Cost. 

Report Location:  Unit Hierarchy 

How Proposal Revenue Projection Reports calculate prorated projections: Calculations 

Definition of Terms:  Column Headings & Terms Defined 
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314: School Proposal Revenue Projection Report 
[return to List of Reports] 

[return to List Proposal Revenue Projection Reports] 

 

Description:  This report provides prorated School Pending Proposal requested amounts, by department, 
for a User-specified date range.  Information provided: Unit number and name, Institute Proposal count, 
Direct Cost, Indirect Cost, and Total Cost. 

Report Location:  Unit Hierarchy 

   

(This dropdown menu overrides any specific unit highlighted in the Unit Hierarchy.) 

How Proposal Revenue Projection Reports calculate prorated projections: Calculations 

Definition of Terms:  Column Headings & Terms Defined 
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316: Enterprise Proposal Revenue Projection Report 
[return to List of Reports] 

[return to List Proposal Revenue Projection Reports] 

 

Description:  This report provides prorated Enterprise Pending Proposal requested amounts, by School, for 
a User-specified date range.  Information provided: Unit number and name, Institute Proposal count, 
Direct Cost, Indirect Cost, and Total Cost. 

Report Location:  Unit Hierarchy  

   

(This dropdown menu overrides any specific unit highlighted in the Unit Hierarchy.) 

How Proposal Revenue Projection Reports calculate prorated projections: Calculations 

Definition of Terms:  Column Headings & Terms Defined 
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318: Investigator Proposal Revenue Projection Report 
[return to List of Reports] 

[return to List Proposal Revenue Projection Reports] 

 

Description:  This report provides prorated Pending Proposal requested amounts, by Investigator across 
the Enterprise, for a User-specified date range.   Information provided: Investigator, Institute Proposal 
count, Direct Cost, Indirect Cost, and Total Cost. 

Report Location:  Unit Hierarchy 

   

(This dropdown menu overrides any specific unit highlighted in the Unit Hierarchy.) 

How Proposal Revenue Projection Reports calculate prorated projections: Calculations 

Definition of Terms:  Column Headings & Terms Defined 
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320, 322, and 324: Success Rate Reports 
[return to List of Reports] 

Description: Proposal success rate for Investigator, Department, School, or Enterprise.  Information 
provided:  Investigator, Department, School, number of Institute Proposals, Funded Institute Proposals, 
and percent funded; also, number of Pending Proposals, and Proposals Not Funded, Withdrawn, or 
otherwise Voided. 

How Success Rate Reports calculate success rates: (Funded Institute Proposals) / (Funded + Not Funded + 
Pending Institute Proposals) 

 

Report Type Description Report 
Location 

Success Rate Reports   

320 Department Success Rate Proposal success rate summarized by Investigator for User-
specified Department Unit Hierarchy 

322 – School Success Rate Proposal success rate summarized by Department for User-
specified School Unit Hierarchy 

324 – Enterprise Success Rate Proposal success rate summarized by School when user 
selects JHU Enterprise Unit Hierarchy 
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320: Departmental Success Rate Report 
[return to List of Reports] 

[return to List Proposal Revenue Projection Reports] 

 

Description: This report is for a User-specified Unit, by Investigator. It shows each Investigator’s level of 
success of proposal funding during a User-specified date range.  Investigator data shown in this report 
pertains only to Institute Proposals created under this reporting unit.  Information provided: Investigator, 
number of Institute Proposals, Funded Institute Proposals, and percent funded; also, number of Pending 
Proposals, and Proposals Not Funded, Withdrawn, or otherwise Voided. 

Report Location:  Unit Hierarchy 

How Success Rate Reports calculate success rates: (Funded Institute Proposals) / (Funded + Not Funded + 
Pending Institute Proposals) 

Definition of Terms:  Column Headings & Terms Defined 
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322: School Success Rate Report 
[return to List of Reports] 

[return to List Proposal Revenue Projection Reports] 

Description: This report is for a User-specified date-range and School. It shows each Department’s level of 
success of proposal funding.  Information provided: Department name, number of Institute Proposals, 
Funded Institute Proposals, and percent funded; also, number of Pending Proposals, and Proposals Not 
Funded, Withdrawn, or otherwise Voided. 

Report Location:  Unit Hierarchy 

   

How Success Rate Reports calculate success rates: (Funded Institute Proposals) / (Funded + Not Funded + 
Pending Institute Proposals) 

Definition of Terms:  Column Headings & Terms Defined 
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324: Enterprise Success Rate Report 
[return to List of Reports] 

[return to List Proposal Revenue Projection Reports] 

 

Description: This report is for a User-specified Enterprise (University or Health System), by School. It 
shows each School’s level of success of proposal funding during a User-specified date range.  Information 
provided: School Unit number and name, number of Institute Proposals, Funded Proposals, and percent 
funded; also, number of Pending Proposals, and Proposals Not Funded, Withdrawn, or otherwise Voided. 

Report Location:  Unit Hierarchy 

  

How Success Rate Reports calculate success rates: (Funded Institute Proposals) / (Funded Institute 
Proposals + Not Funded Institute Proposals + Pending Institute Proposals) 

Definition of Terms:  Column Headings & Terms Defined 
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326 and 328: Funding Status Reports 
[return to List of Reports] 

Description: Total of Pending Proposals and Awards for the current budget period, for School or 
Enterprise.  Information provided:  Department or School Unit number and name, Pending Proposals: 
number, Direct Cost, Indirect Cost, Total Cost; Awards: number, Direct Cost, Indirect Cost, and Total Cost. 

 

Report Type Description Report 
Location 

Funding Status Reports   

326 - School Funding Status Total Pending Proposals and Awards for the current budget 
period, by School Unit Hierarchy 

328 – Enterprise Funding Status Total Pending Proposals and Awards for the current budget 
period, by Enterprise Unit Hierarchy 
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326: School Funding Status Report 
[return to List of Reports] 

[return to List Proposal Revenue Projection Reports] 

 

Description: Provides a count of Pending Proposals and Awards for School, by Department.  Displays 
Pending Proposals requested amounts for the First Budget Period and Active Awards incremental award 
amounts applicable to the JHU Fiscal Year in which the report is generated.  Pending Proposals and 
Awards beginning after the end of the current Fiscal Year are not included.  Information provided: 
Department Unit number and name, Pending Proposals: number, Direct Cost, Indirect Cost, Total Cost; 
Awards: number, Direct Cost, Indirect Cost, and Total Cost. 

 Report Location:  Unit Hierarchy 

Definition of Terms:  Column Headings & Terms Defined 
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328: Enterprise Funding Status Report 
[return to List of Reports] 

[return to List Proposal Revenue Projection Reports] 

 

Description: Provides a count of Pending Proposals and Awards for Enterprise, by School.  Displays 
Pending Proposals requested amounts for the First Budget Period and Active Awards incremental award 
amounts applicable to the JHU Fiscal Year in which the report is generated.  Pending Proposals and 
Awards beginning after the end of the current Fiscal Year are not included.  Information provided: School 
Unit number and name, Pending Proposals: number, Direct Cost, Indirect Cost, Total Cost; Awards: 
Number, Direct Cost, Indirect Cost, and Total Cost. 

Report Location:  Unit Hierarchy 

Definition of Terms:  Column Headings & Terms Defined 
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Proposal Development Reports (500 series) 

500e: Routing Analysis Excel Data File 
[return to List of Reports] 

Description: This report contains Proposal Development records with a status other than Recalled or 
Rejected for a User-specified Unit and date range.  The date range is determined by the date that the 
Proposal Development record was first routed for approval.  The report includes details about the 
Proposal Development record as well as routing information: the user who started approval, when 
approval was started, the user who finished approval, when approval was completed, and several 
other pieces of information.  In addition, if the proposal was submitted to Grants.Gov, the report 
includes the Grants.Gov Application Type and Status.   

*Note: The information in this report is updated once a day at 6:00AM.  See the footnote at the 
bottom of the Excel Data File. 

Report Location:  Unit Hierarchy 

Definition of Terms:  Column Headings & Terms Defined 

Information provided:  

Proposal Development Proposal Type Activity Type Anticipated Award Type 

Status Title Business Area Unit Number 

Unit Name Department Division Aggregated Division 

Principal Investigator Sponsor Code Sponsor Sponsor Type 

Aggregated Sponsor Type Prime Sponsor Code CFDA Number Announcement Number 

System-to-System Type System-to-System Submission 
Status 

Deadline Routing Start User 

Routing Start Date Weekdays Routed Before 
Deadline 

Routing Next Approver ORA Receipt Date First 
Attempt 

Weekdays ORA Received 
before Deadline 

ORA Receipt Date Final 
Attempt 

Routing End User Routing End Date 

Routing Attempts ORA Fiscal Year Fiscal Month 

Institute Proposal    

Notice about Descriptors 

Caution: if the following fields 
are removed from the 

spreadsheet ORIS will be 
unable to validate the data. 

Report Number Report Title Parameter Entered 1 

Parameter Entered 2 Parameter Entered 3 Run Time Host Name 

 

The following page includes a partial sample report. 
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510: Coeus Users in Unit Report 
[return to List of Reports] 

Description: This report is intended for use by administrators.  The report lists each Coeus user with an 
active account within a User-specified Unit.  Information provided: each active Coeus user (ID, Name, 
user’s Unit, Home Unit, Email Address in Coeus) and their assigned Coeus Roles. 

Report Location:  Unit Hierarchy 

Definition of Terms:  Column Headings & Terms Defined 
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Person Reports (700 series) 

700: Investigator History Report 
[return to List of Reports] 

Description: This report contains all Awards and Institute Proposals, by award and proposal status, for a 
User-specified Investigator.  Proposals not yet submitted to Sponsor are not included.  Investigator data 
shown in this report pertains to ALL proposals and projects on which the Investigator is PI.  Information 
provided: Award number, Institute Proposal number and link to Proposal Summary, Sponsor Name, 
Sponsor Award number (SAP Award ID), Award Type, Activity Type, Proposal Type, Start/End dates, Direct 
Cost and Total Cost.  Investigator selected is a Co-investigator on proposals that do not contain dollar 
amounts (see Pending below).   

Report Location:  Person Search 

Definition of Terms:  Column Headings & Terms Defined 
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702e: Other Support Tool 
[return to List of Reports] 

Description: This tool is a worksheet - not a report - designed in cooperation with departmental 
administrators to assist them to complete the Investigator’s Other Support Report for Federal Sponsors.  
In this Tool the Investigator is referred to as the “Target Investigator”, or TI.  The tool searches Coeus 
Institute Proposals and SAP GM Grant Master Data for any proposal on which the TI may have had Effort 
proposed and which proposal is Pending or is Funded on the User-specified ‘As of’ date. 
 
The Tool consists of two Parts, each a unique search of databases in Coeus and GM Grant Master Data:  
“Part 1: TI is PI or Co-I on [active] SAP GM Grant Master Data awarded and [pending] Coeus Inst. 
Proposals.” 

Is a search of all grants in Coeus Award with a Status of Active, GM Grant Master Data with Status 
Approved Award, and all Coeus Institute Proposals records with a Status of ‘Pending’.  It returns those 
records on which the Target Investigator is named as either the PI or a Co-I. 

“Part 2: TI is named on another PI’s [funded] Inst. Proposal and [active] GM Grant award.” 

Is a search of all Funded Institute Proposal Records on which the Target Investigator’s name appears as 
Co-I or Key Person.  It excludes those records found in Part 1.  This search is necessary because both GM 
Grant and Coeus Award have narrow definitions of ‘Co-I’. It returns those records in which the Target 
Investigator is a Co-I or Key Person on the proposal as submitted.  

Report Location:  Person Search 

Definition of Terms:  Column Headings & Terms Defined 

Information provided: 

Target Investigator 

Investigator for whom Other 
Support analysis is being 
performed.  The person 
initially searched for in Coeus.  

Proposal Status 

‘Funded’ – proposal is awarded 
and currently active in SAP.  

‘Pending’ – proposal is pending 
and considered to be still under 
review by the sponsor (*).  

(*)Users should notify ORA if a 
Pending proposal will not be 
funded. ORA will update. 

Project Start Date 

Status ‘Funded’ - Project start 
date as shown in GM Grant of 
the funded award. 

Status ‘Pending’ – Project start 
date proposed in the Proposal 
submitted to sponsor.  The 
initial IP date is shown if 
multiple proposals were 
submitted. 

Project End Date 

Status ‘Funded’ - Project end 
date as shown in GM Grant of 
funded award. 

Status ‘Pending’ – Project end 
date proposed in the Proposal 
submitted to sponsor.  The 
initial IP date is shown if 
multiple proposals were 
submitted. 

Period Start Date 

Status ‘Funded’ – Budget 
Begin Date on GM Grant 
Award Year Breakdown tab 
(AYB) of the current award 
period based on the User-
specified ‘As Of’ date, 
Parameter 2, provided in the 
report. 

Status ‘Pending’ – Start date 
of the first year/period in the 
Institute Proposal (IP) record. 

Period End Date 

Status ‘Funded’ – Budget End 
Date on GM Grant Award Year 
Breakdown tab (AYB) of the 
current award period based on 
the User-specified ‘As Of’ date, 
Parameter 2, provided in the 
report. 

Status ‘Pending’ – Start date of 
the first year/period in the 
Institute Proposal (IP) record. 

Award Action 

Status ‘Funded’ - GM 
Grant>AYB Award Action 
Column for the AYB line(s)(*) 
encompassing the User-
Specified ‘As Of’ date, 
Parameter 2, provided in the 
report.  

(*)Supplements awarded in the 
current period appear in 
separate lines in both AYB and 
this report. 

Status ‘Pending’ – Always ‘N/A’, 
not applicable to proposals 
records. 

 

Direct Cost 

Status ‘Funded’ – GM 
Grant>AYB Direct dollar 
amount for the AYB line(s)(*) 
encompassing the User-
Specified ‘As Of’ date, 
Parameter 2, provided in the 
report.  

(*)Supplements awarded in 
the current period appear in 
separate lines in both AYB and 
this report. 

Status ‘Pending’ – Direct dollar 
amount of the first year/period 
in the Proposal budget. 
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IP (Proposed) Effort % 

This is always the Effort 
proposed in the Original 
Institute Proposal (IP) record 
for the Target Investigator. 

IP_PI /Person Name(*) 

Part 1 – ‘IP_PI’ is the PI on the 
displayed record, both SAP 
Award and Coeus IP. 

Part 2 – ‘Person Name’ is the 
Target Investigator. 

(*)This is the only column in 
which Part 1 and 2 have 
different headings/purposes. 

Award ID 

If Status ‘Funded’ – Award ID 
assigned by sponsor if noted in 
GM Grant. 

If Status ‘Pending’ – Always 
‘NA’, no data returned. 

Title 

If Status ‘Funded’ – Title of GM 
Grant Award. 

If Status ‘Pending’ – Title of 
proposal as submitted and 
shown on initial IP. 

Award PI 

If Proposal Status is ‘Funded’, 
then Award PI is the PI on GM 
Grant. 

If Proposal Status ‘Pending’, no 
award has been made, so 
Award PI = NA. 

Sponsor Acronym 
 

Acronym assigned to sponsor 
by SSPS. 

Sponsor 
 

Sponsor name assigned to 
sponsor by SSPS. 

Purpose 
 
If Status ‘Funded’ – Purpose is 
derived from GM Program 
(Primary IO)>Additional Data 
Tab>F&A Function.  
 
If Status ‘Pending’ – Proposal 
Activity Type submitted to 
sponsor. 

Proposal Type 
 

If Status ‘Funded’ – from the IP 
Proposal Type.  See below.  
 
If Status ‘Pending’ –from the 
original proposal submitted to 
sponsor. 

Award Type 
 

If Status ‘Funded’ – from GM 
Grant>General Data 
Tab>Award Type.  
 
If Status ‘Pending’ – from 
Anticipated Award Type on the 
original proposal submitted to 
sponsor. 

SAP Number 
 
If Status ‘Funded’ – six-digit 
Award number assigned by 
Sponsored Projects Shared 
Services. 
 
If Status ‘Pending’ – NA. 

Proposal Number 

If Status ‘Funded’ – from IP 
number of proposal as listed 
on the ‘Reference’ tab in GM 
Grant. 

If Status ‘Pending’ – IP number 
of proposal. 

Grant Status 

Part 1 - If Status ‘Active’ – 
means that award is active in 
Coeus Award &/or Approved 
Award in SAP MG Grant. 

If record is a ‘Pending’ IP, then 
NA is displayed. 

Part 2 – If Status is ‘Active – 
means award has SAP Status of 
Approved Award. 

 

 

NOTE 

This last cell in report is a text 
field for comments by Preparer 

and ORA Reviewer. 

Important Notice 
The following data columns, known as 
Data Descriptors, are placed into each row 
of every ORIS Excel report in which the 
Report number ends in ‘e’.  The 
Descriptors authenticate the row of data 
by telling users how to replicate that data.  
ORIS cannot validate any data from which 
these Descriptors have been removed. 

Report Number 
ORIS Report number. 

Parameter 1 
Person ID of the Target Investigator. 

Parameter 2 
User-specified date “Other Support As of”.  
This is the date used to determine which 
records and AYB lines should be displayed 
in this report. 

Run Time 
Date and Time at which report was 
generated. 

Report Title 
ORIS Report title. 

Host Name 

ORIS name assigned to version of Coeus 
on which the report was generated. 

PRCOEUS is the main ‘production’ version 
at JHU. 

NOTE 

This last cell in report is a text field for 
comments by Preparer and ORA Reviewer. 
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Part 1 

Part 2 
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710: Coeus Roles for User Report 
[return to List of Reports] 

Description: This report is intended for use by administrators.  The report lists, for user-specified person, 
by Unit, each assigned Coeus role. Information provided: User Name, Unit Number, Unit Name, and Coeus 
roles assigned. 

Report Location:  Person Search 

Definition of Terms:  Column Headings & Terms Defined 
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Report Locations 

Person Search 
[return to List of Reports] 

Select: Departmental>Personnel from Top Menu Bar or Select this Icon  

 

 Enter: Investigator information [use only one of the formats shown] 

 

Highlight:  name in Person list 

 

Select: Report Title from Report>Menu 
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Unit Hierarchy Search 
[return to List of Reports] 

Overview of Search in the Unit Hierarchy 

To run ORIS Reports using the Units Hierarchy the User must first open the Coeus Unit Hierarchy screen: 

Select:  Admin>Unit Hierarchy, from Top Menu Bar…or, Select this Icon  

 

 
Choose: one of two Approaches to tell Coeus which Unit (or group of Units) to include in the ORIS 
Report: 

 Approach 1  - for those new to ORIS Reports 
 Approach 2  - for experienced ORIS Reports Users 

 

Note: The Coeus Unit number, while corresponding to the SAP Cost Center number, is eight digits in length not 
ten.  Coeus drops the two right-most digits in the SAP Cost Center number. 

Approach 1:  Find Unit by ‘drilling down’ the Hierarchy 

First-time Users may find the ‘drilldown’ approach depicted below to be most useful.  By Selecting 
successive “+” signs, one can display subordinate units to be reported in the ORIS Report. 

Select:  ‘+’ signs to display Unit detail  
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Highlight:  Unit to be reported (ex. 17015110) 

 

Select: Report Title from Report>Menu 
 

 

Select: Report Parameters [example only] 
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Approach 2:  Search by Unit Number 

Experienced Users, those who know the Unit number in the Unit Hierarchy, may prefer this approach.  By 
following a few simple steps, the User can go directly to the Unit and run the report.  Shown below are 
three common reporting levels (levels of data aggregation) for School, Department, Sub-department or 
Center.  Within Unit Hierarchy: 

Select: Search Icon to open Unit Search screen 

 

Enter: eight-digit Unit number, ‘*’ asterisk is useful search tool  

 School: 17000000 

 

 Department: 17015000 

 

 Sub-department or Center: 17015110, or 1701511* 

 

Highlight:  Unit the Search ‘Result’ 
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Coeus Highlights that Unit in the Unit Hierarchy: 

 
 

Select: Report Title from Report>Menu 

 

 
Select: Report Parameters - if required 

 

Select: ‘Report Format’: 

 
Select: ‘Print’: 
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Column Headings & Terms Defined 

[return to List of Reports] 

 

1. Activity Type – is the primary function of the award.  The Activity Types are Organized Research, Other 
Sponsored Activity, Instruction, and Clinical Research. 

2. Aggregated Division – is an aggregation of the Divisions into the seven following categories: Bloomberg 
School of Public Health, Krieger School of Arts & Sciences, School of Education, School of Medicine, School 
of Nursing, Whiting School of Engineering, and the catch-all category All Others. 

3. Aggregated Sponsor Type – is an aggregation of the Sponsor Types into the nine following categories: 
DHHS (Department of Health & Human Services), DOD (Department of Defense), Foreign, 
Foundation/Non-Profit, Institution of Higher Education, NSF (National Science Foundation), Other Federal, 
Private Profit, and State/Local Government. 

4. Announcement Number – is the sponsor’s funding opportunity number. 

5. Anticipated Award Type – see Award Type. 

6. Anticipated Total – is the SAP GMGrant’s Funded Amount.  The Anticipated Total is the amount of funding 
that the sponsor has promised the university over the entire life of the SAP Grant. 

7. ARRA Award – is a SAP Grant with an Award Type of ARRA Contract, ARRA Grant, ARRA Subcontract, or 
ARRA Subgrant.  Denotes that the funding was part of the American Recovery & Reinvestment Act. 

8. ARRA Proposal – is an Institute Proposal containing an ARRA Science Code.  Denotes that the proposal 
was submitted in response to an American Recovery & Reinvestment Act funding opportunity. 

9. Award Number - is the SAP six-digit award number. 

10. Award ID – this is the Award ID assigned by the sponsor if entered into SAP GM Grant Master Data.  

11. Award Action – describes the specific reason for an increment of funding on a grant and is from GM 
Grant>Award Year Breakdown tab>Award Action field. 

12. Award Date –is the Award Date listed in SAP GMGrant’s Award Year Breakdown tab.  The Award Date is 
the fully executed date of the notice of award that provided funding. 

13. Award End – is the SAP GMGrant’s Project End Date. 

14. Award Start – is the SAP GMGrant’s Project Start Date. 

15. Award PI – is the PI on the GM Grant Master data, if the Institute Proposal Status is ‘Funded’. 

16. Award Status - see the Status definitions.  The possible Award Statuses are Active, Pre Award, and 
Terminated. 

17. Award Type – is the nature, category, of funding agreement underlying the award.  The Award Types are 
Grant, Subgrant, Contract, Subcontract, Cooperative Agreement, Clinical Trial, and Fixed Fee.  *See the 
specific definition for ORIS Report 702e Other Support Tool in that report’s detailed description. 

18. Business Area – is the first three digits of the SAP Responsible Cost Center.  The Business Area is unique to 
the School.  For example, the Business Area for the School of Medicine is 170. 

19. CFDA Number – is the Catalog of Federal Domestic Assistance number assigned by sponsor for funding 
opportunity. 

20. Current Budget Period – when included in a column heading (ex. #104/105), this means that data displayed 
in the report is not total dollars, but rather first-period budget dollars of a pending Proposal and the 
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awarded dollars that correspond to the JHU Fiscal Year in which the report is generated and which are 
contained in SAP>GM Grant>Award Year Breakdown screen. 

21. Deadline – is the sponsor’s Deadline Date for the proposal as entered in the Proposal Development record.  
Deadline Dates are required for Grants.Gov proposals. 

22. Department – is the Department based on the Unit Number.  The Department is one level above the Unit. 

23. Direct & Direct Cost– is the total direct costs.  When referenced for Awards, this is the SAP GMGrant 
Master Data total direct costs from the Award Year Breakdown Tab.  When referenced for Institute 
Proposals, this is the total direct costs from the Institute Proposal. 

24. Division – is the Division based on the Unit Number.  The Division is one level above the Department; two 
levels above the Unit. 

25. Employee ID – is the Person ID number from SAP HR.  This is the unique, unchanging, numerical identifier 
for Johns Hopkins employees.  The Person ID matches the employee’s first Personnel Number (PERNR) – 
an employee can have multiple Personnel Numbers which is why the Personnel Number is not used in ORIS 
Reports.  In ORIS Reports, the Employee ID is the Person ID number for the person referenced in the 
report.  For example, in ORIS Report 302e, the Employee ID column is beside the Principal Investigator 
column so the Employee ID listed is that of the Principal Investigator. 

26. End – is the End Date.  When referenced for Awards, this is from SAP GMGrant Master Data.  When 
referenced for Institute Proposals, this is the proposed/requested end date. 

27. Fiscal Month – is the number of the JHU Fiscal Month.  For example, ‘01’ is July.  The Fiscal Month could be 
based on any date so be sure to reference the specific Report Catalog for details. 

28. Fiscal Year – is the last two digits of the JHU Fiscal Year.  For example, JHU’s Fiscal Year 13 runs from July 1, 
2012 to June 30, 2013.  The Fiscal Year could be based on any date so be sure to reference the specific 
Report Catalog for details. 

29. Grant Status – [702e Other Support only] in the Part 1 Status ‘Active’ means that award is active in Coeus 
Award &/or is Approved Award in SAP MG Grant.  If record status is ‘Pending’ it is an IP record and ‘NA’ is 
displayed. Part 2 – Status ‘Active’ means award has SAP Status of Approved Award. 

30. Home Unit – is the SAP Cost Center assigned to the Coeus User’s OM (Payroll) position.  Home Unit is 
imported into Coeus from SAP HR along with other person data.  This field is editable within each proposal 
development record during its preparation.  It can also be edited by users assigned the role of Person 
Maintainer. 

31. Indirect – is total F&A costs.  When referenced for Awards, this is the SAP GMGrant Master Data total 
indirect costs from the Award Year Breakdown Tab.  When referenced for Institute Proposals, this is the 
total indirect costs from the Institute Proposal. 

32. Inst. Prop – See Inst. Proposal 

33. Inst. Proposal - Institute Proposals are a copy the Proposal Development records upon submission to the 
sponsor.  Institute Proposals track the sponsor’s funding decision.  The IP number consists of 8 digits, 
where the first four contain the JHU Fiscal Year and Fiscal Month in which the proposal was first submitted 
by the PI for approval by ORA, e.g. 1001xxxx represents a submittal in FY 2010, July 2009.  IP Statuses are: 
Pending, Funded, Not Funded, Withdrawn, and Void. 

34. IP (Proposed) Effort % - Effort assigned to Target Investigator in the Coeus original Institute Proposal 
record. 

35. IP_PI / Person Name – IP_PI in 702e Part 1 is the PI on the Coeus Inst. Proposal record.  Person Name in 
Part 2 is the name of the Target Investigator.    
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36. IPN Link – when the Institute Proposal number is underscored in a report, the Institute Proposal is 
hyperlinked to the ORIS Proposal Summary Form.  Opening the IPN link will provide the reader with useful 
information from the initial proposal submission: PI and Co-PIs, proposed effort, certain proposed budget 
information, as well as the various questions originally completed. 

37. ORA – is the Office of Research Administration.  There are five ORAs at JHU: Bloomberg School of Public 
Health ORA, Business and Research Administration (BARA) ORA servicing the Krieger School of Arts & 
Sciences, Research Projects Administration (RPA) servicing the Whiting School of Engineering and other 
university divisions, School of Medicine ORA, and the School of Nursing ORA. 

38. ORA Receipt Final Attempt – is the date on which the ORA received the Proposal Development record on 
the final (or current) attempt of review and approval. 

39. ORA Receipt First Attempt – is the date on which the ORA first received the Proposal Development record 
for review and approval. 

40. Period Start/End Dates – [702e only] if Status is Funded the dates are pulled from GM Grant Master 
Data>Award Year Breakdown>Budget Begin or Budget End Dates for specific row retrieved. If Status is 
Pending the dates are pulled from Institute Proposal record>Initial Budget Period Start and End dates. 

41. Principal Inv. – is the Principal Investigator.  When referenced for Awards, this is from SAP’s GMGrant 
Master data.  When referenced for Institute Proposals, this is from the Institute Proposal record. 

42. Prime Sponsor Code – is the Sponsor Code listed for the Prime Sponsor. 

43. Project Start/End Dates –are the dates on which the entire Project (proposed project and awarded 
project) begin and end. 

44. Prop Development – is the Proposal Development number. 

45. Prop Type – See Proposal Type 

46. Proposal Number – is the Inst. Proposal number. 

47. Proposal Type – is the Proposal Type on the original submitted proposal.  For Institute Proposal ORIS 
Reports, only Proposal Types New, Renewal, Supplement, Resubmission, and Task Order are included.  For 
Proposal Development ORIS Reports, all Proposal Types are included. 

48. Proposal Status – see the Status definitions.  The possible Institute Proposal statuses are Funded, Not 
Funded, Pending, Withdrawn, and Void.  There are also several Proposal Development statuses included in 
the status definitions. 

49. Prorated calculations – the Financial Reports (Series 400) make extensive use of apportioning awards 
(grants) and requested funds (proposals) to User-specified data ranges.  Calculation methods are defined 
in this Guide, Section “How are prorated amounts calculated…?” 

50. Purpose – if Inst. Proposal Status is Funded the Purpose is derived from Award records Primary IO>GM 
Program>Additional Data Tab>F&A Function.  If Inst. Proposal Status is Pending the Purpose is derived 
from the Proposal Activity Type submitted to sponsor.  

51. Rate of Funding – is the percentage of the total requested funding that was awarded by the sponsor.  Rate 
of Funding = Anticipated Total / Request Total Period Total for Institute Proposals that have a status of 
Funded.  For example, if the proposal requested $100,000, but the sponsor only awarded $95,000, then 
the Rate of Funding for this project is 0.95 (or 95%).  Another way to think about the Rate of Funding is by 
how much the sponsor cut the project’s budget.  The Budget Cut is 1 minus the Rate of Funding.  Budget 
Cut = 1 – Rate of Funding for Institute Proposals that have a status of Funded.  For the example above, the 
Budget Cut for this project is 0.05 (or 5%). 

52. Request First Period Direct – is the First Period’s requested direct amount from the Institute Proposal. 

53. Request First Period End – is the First Period’s requested end date from the Institute Proposal. 
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54. Request First Period Indirect – is the First Period’s requested indirect amount from the Institute Proposal. 

55. Request First Period Start – is the First Period’s requested start date from the Institute Proposal. 

56. Request First Period Total – is the First Period’s requested total amount (direct + indirect) from the 
Institute Proposal. 

57. Request Total Period Direct – is the proposal’s requested total direct amount from the Institute Proposal. 

58. Request Total Period End – is the proposal’s requested end date from the Institute Proposal. 

59. Request Total Period Indirect – is the proposal’s requested total indirect amount from the Institute 
Proposal. 

60. Request Total Period Start – is the proposal’s requested start date from the Institute Proposal. 

61. Request Total Period Total – is the proposal’s requested total amount (direct + indirect) from the Institute 
Proposal. 

62. Revenue Projection Reports –prorate projected amounts within a User-specified date-range, usually a 
fiscal year.  Projections are displayed for awarded projects and pending projects, where: 

a) Awarded projects: prorated amounts are calculated from active awards within a user specified 
date-range, using SAP GMGrant>Award Year Breakdown details.  See the above definition of 
‘Active’, because the Coeus definition is used, not SAP GMGRANT definition.  

b) Pending projects: prorated amounts are calculated from proposed total funding contained in the 
Coeus Institute Proposal total budgets where the IP has a Status of Pending.  This approach 
approximates proposed research budgets. 

63. Roles(s) – specific functionality assigned to Coeus users.  Roles are defined in the Reference guide: “Coeus 
Roles and Rights” at http://prcoeus.johnshopkins.edu/orisite/oris_web/oris_index.html. 

64. Routing Attempts – is the number of times that the Proposal Development record had to be routed for 
department and/or ORA review and approval. 

65. Routing End – is the date the Proposal Development record finished reviews and approvals.  If this is blank, 
the Proposal Development record has not yet finished all reviews and approvals. 

66. Routing End User – is the ORA Approver that completed the review and approval of the Proposal 
Development record.  If this is blank, the Proposal Development record has not yet finished all reviews and 
approvals. 

67. Routing Next Approver – is the Primary Approver of the stop at which the Proposal Development record is 
currently being reviewed and waiting for approval.  If this is blank, the Proposal Development record has 
finished all reviews and approvals. 

68. Routing Start – is the date the Proposal Development record begins reviews and approvals. 

69. Routing Start User – is the aggregator of the Proposal Development record that initiates reviews and 
approvals. 

70. S2S Status, Agency Tracking Number Assigned – is the system-to-system Status for proposals that were 
submitted error-free to Grants.Gov. 

71. S2S Status, Grants.Gov Submission Error – is the system-to-system Status for proposals that were found 
with errors at time of submission. 

72. S2S Status, Received by Agency – is the system-to-system Status for proposals that did not pass sponsor 
validations. 

73. S2S Status, Rejected with Errors – is the system-to-system Status for proposals that did not pass 
Grants.Gov validations. 

http://prcoeus.johnshopkins.edu/orisite/oris_web/oris_index.html
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74. S2S Type – is the system-to-system Application Type as shown in the Grants.Gov window of the Proposal 
Development record.  The system-to-system Application Types are Application, Pre-Application, and 
Change/Corrected Application. 

75. SAP Number – is the six-digit grant number assigned by Sponsored Projects Shared Services. 

76. Sponsor – is the sponsor for the project.  When referenced for Awards, this is the sponsor as contained in 
SAP GMGrant Master Data.  When referenced for Institute Proposals, this is the sponsor as referenced on 
the record in Coeus. 

77. Sponsor Acronym – is the acronym assigned to the sponsor by Sponsored Projects Shared Services. 

78. Sponsor Award # – is the Award ID from SAP GMGrant Master Data.   

79. Sponsor Code – is the Sponsor’s six digit code. 

80. Sponsor Type – is the category of the Sponsor. 

81. Start – is the Start Date.  When referenced for Awards, this is from SAP GMGrant Master Data.  When 
referenced for Institute Proposals, this is the proposed/requested start date. 

82. Status, Active – is the Coeus Award Status when the SAP Grant User Status is “Approved Awarded” and 
the SAP Project End Date is on, or after, today’s date.  See Caveat 2. 

83. Status, Approved – is the Proposal Development Status for proposals that have been approved by the 
ORA, but not yet submitted to the sponsor. 

84. Status, Approval in Progress – is the Proposal Development Status when the proposal is undergoing 
review and approval by the department and/or ORA. 

85. Status, Funded – is the Institute Proposal Status when the award is created in SAP GM Grant. 

86. Status, Pending – is the Institute Proposal Status when the sponsor has yet to render a funding decision.  
Coeus automatically changes the Status from Pending to Not Funded 365 days after the 
proposed/requested start date. 

87. Status, Post-Submission Approval – is the Proposal Development Status for proposals that have been 
submitted to the sponsor, but are still undergoing review and approval by the department and/or ORA. 

88. Status, Post-Submission Rejection – is the Proposal Development Status for proposals that have been 
submitted to the sponsor before review and approval by the department and/or ORA.  During the post-
submission review and approval, the proposal was found to be incomplete or inaccurate. 

89. Status, Submitted – is the Proposal Development Status for proposals that have been approved and 
submitted to the sponsor. 

90. Status, Terminated – is the Coeus Award Status when the Award is from ReSource (ended prior to SAP 
startup on 1/1/07) and therefore was not assigned an SAP Grant number, the SAP Grant has a User Status of 
“Temporarily Closed”, or the SAP Grant has a User Status of “Approved Awarded” and the SAP Project 
End Date is before today’s date (See Caveat 2). 

91. Status, Not Funded – is the Institute Proposal Status when the sponsor notified JHU that the proposal 
would not be awarded. 

92. Status, Withdrawn – is the Institute Proposal Status when the Investigator decided to remove the 
proposal from sponsor consideration after the proposal was approved for submission by ORA. 

93. Status, Void – is the Institute Proposal Status of a proposal never submitted to sponsor and removed from 
further consideration. 

94. Subcontract Flag – is the checkbox in the Coeus proposal record that indicates whether or not the 
proposal contains a subcontract.  A check (“Yes”) indicates a subcontract and a blank box (“No”) indicates 
the absence of a subcontract. 
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95. Submission Date – is the creation date of the Institute Proposal.  Since the Institute Proposal is created 
when the ORA selects the “Approve” or “Submit to Sponsor” buttons, the Submission Date should be the 
date that the proposal is submitted to the sponsor. 

96. Success Rate – number of Institute Proposals with a Status of Funded divided by the sum of Institute 
Proposals with a Status of Pending, Funded, and Not Funded.  Success Rate = # of Funded Institute 
Proposals / (# of Pending + # of Funded + # of Not Funded Institute Proposals) 

97. Target Investigator – [702e only] the Investigator for whom Other Support analysis is being performed 
and the person initially searched for to generate the 702e report. 

98. Title – is the project title.  When referenced for Awards, this is from SAP GMGrant Master Data.  When 
referenced for Institute Proposals, this is the title from the Institute Proposal in Coeus. 

99. Total – total costs.  When referenced for Awards, this is the amount shown in the SAP GMGrant Master 
Data, Funded Amount field.  When referenced for Institute Proposals, this is the total amount 
proposed/requested. 

100. Tot. Direct & Tot. Indirect Cost – when an award falls within a user-specified date-range, the entire Direct 
Cost and Indirect Cost is shown.  These amounts are not prorated or otherwise apportioned.  This applies 
to Report 202.   

101. Unit Name – is the assigned name for the Coeus unit number. 

102. Unit Number – is the Coeus unit number assigned for a School, department, or center.  Generally, Coeus 
unit numbers closely correspond to the SAP Cost Center numbers. 

103. User’s Unit – is the Coeus Unit number in which User’s first Coeus role was assigned, or the Unit number 
subsequently edited by ORIS.  This field can only be edited by ORIS.  

104. Weekdays Routed Before DL – is the number of weekdays that the Proposal Development record first 
began reviews and approvals before the Deadline Date, not including the Deadline Date. 

105. Weekdays ORA Received Before DL – is the number of weekdays that the ORA first received the Proposal 
Development before the Deadline Date, not including the Deadline Date. 


	List of Reports
	Table of Contents
	Before You Begin
	First-time Users
	Follow these steps

	What are sources of ORIS Report data?
	Important caveats:
	What does ‘Active’ Award mean in Coeus?
	What Proposal Types are included in Institute Proposal ORIS Reports?
	What to do if your ORIS ‘e’ report displays xml code, in red ink, and not Excel?

	Where to report data errors found in ORIS Reports?
	Where to direct questions about accessing or generating ORIS Reports?

	Catalog of ORIS Reports
	Award Reports (100 series)
	100: Active Awards
	100e: Active Awards Excel Data File
	102: Awards Received by Start Date Report
	104/104e: Award Years Received by Start Date Report
	110, 112, 114, 116, and 118: Award Revenue Projection Reports

	Award Revenue Projection Calculations
	How Revenue is projected from GM Grant Master Data>Award Year Breakdown.
	110: Investigator Award Revenue Projection Report
	112: Department Award Revenue Projection Report
	114: School Award Revenue Projection Report
	116: Enterprise Award Revenue Projection Report
	118: Investigator Award Revenue Projection Report

	Institute Proposal Reports (300 series)
	300: Pending Proposals Report
	300e: Pending Proposals Excel Data File
	302e: Funding Analysis Report
	310, 312, 314, 316, and 318: Proposal Revenue Projection Reports

	Pending Proposal Budgeted Revenue Projection Calculations
	How Revenue is projected from Pending Proposals.
	310: Investigator Proposal Revenue Projection Report
	312: Department Proposal Revenue Projection Report
	314: School Proposal Revenue Projection Report
	316: Enterprise Proposal Revenue Projection Report
	318: Investigator Proposal Revenue Projection Report
	320, 322, and 324: Success Rate Reports
	320: Departmental Success Rate Report
	322: School Success Rate Report
	324: Enterprise Success Rate Report
	326 and 328: Funding Status Reports
	326: School Funding Status Report
	328: Enterprise Funding Status Report

	Proposal Development Reports (500 series)
	500e: Routing Analysis Excel Data File
	510: Coeus Users in Unit Report

	Person Reports (700 series)
	700: Investigator History Report
	702e: Other Support Tool
	710: Coeus Roles for User Report


	Report Locations
	Person Search
	Unit Hierarchy Search
	Overview of Search in the Unit Hierarchy
	Approach 1:  Find Unit by ‘drilling down’ the Hierarchy
	Approach 2:  Search by Unit Number


	Column Headings & Terms Defined

